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VOCATIONAL DIPLOMA IN COMPUTER 

APPLICATIONS EXAMINATION  

DECEMBER 2020 

WINDOWS AND INTERNET  

Time : 3 hours Maximum marks : 75 

PART A — (5  5 = 25 marks) 

Answer any FIVE questions. 

1. What are the advantages of computer? Explain.  

 

2. What is control panel? Explain. 

 

3. Explain working with colors in paint. 
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4. What are procedures to insert object in WordPad? 

 WordPad object 

 

5. Explain any one browser. 

 

6. How to create new picture? Explain. 

 

7. What is data and information? Explain. 

 

8. Explain recycle bin. 

 Recycle bin  

PART B — (5 × 10 = 50 marks) 

Answer FIVE questions, question 9 and 10 compulsory. 

9. Choose the correct answer :   (10  1 = 10) 

 (a) Which of the following are components of 

Central Processing Unit? 

  (i) Arithmetic logic unit, Mouse 

  (ii) Arithmetic logic unit, Control unit 

  (iii) Arithmetic logic unit, Integrated 

Circuits 
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 (CPU) 

  (i)  

  (ii) 

 

  (iii)  

 (b) Where is RAM located? 

  (i) Expansion Board 

  (ii) External Drive 

  (iii) Mother Board 

  RAM  

  (i)  

  (ii)  

  (iii)  

 (c) Which of following is used in RAM? 

  (i) Conductor 

  (ii) Semi Conductor 

  (iii) Vaccum Tubes 

  RAM  

  (i)  

  (ii)  

  (iii)  
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 (d) By pressing which key we can move to 

beginning of a page? 

  (i) Window Key 

  (ii) Shift Key 

  (iii) Home Key 

 

  (i)  

  (ii)  

  (iii)   

 (e) From which year 5th generation of computers 

is considered? 

  (i) 1970 

  (ii) 1980 

  (iii) 1990 

 

  (i) 1970 

  (ii) 1980 

  (iii) 1990 
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 (f) What is full form of HTTP? 

  (i) Hyper Transfer Text Protocol 

  (ii) Hyper Text Transfer Protocol 

  (iii) Hexagonal Text Transfer Protocol, 

   HTTP 

  (i) Hyper Transfer Text Protocol 

  (ii) Hyper Text Transfer Protocol 

  (iii) Hexagonal Text Transfer Protocol, 

  (g) Which among following is an image name 

extension? 

  (i) .gif 

  (ii) .docx 

  (iii) .ppt 

   Image

  (i) .gif 

  (ii) .docx 

  (iii) .ppt 
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 (h) Charles Babbage designed the first 

mechanical computer named 

  (i) Analytical Engine 

  (ii) Processor 

  (iii) Comp Engine 

 

  (i)  

  (ii)  

  (iii)  

 (i) Which is following is not an operating 

System? 

  (i) Unix 

  (ii) Windows 

  (iii) Java 

 operating system 

  (i)  

  (ii)  

  (iii)  
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 (j) Random Access Memory (RAM) is which 

storage of device? 

  (i) Primary 

  (ii) Secondary 

  (iii) Ternary. 

 RAM 

  (i)  

  (ii)  

  (iii)  

10. State whether the following are true or false.  

       (10  1 =10) 

 (a) A folder has the same meaning as the term 

directory. 

 

 (b) The Windows Task Bar shows which 

programs are currently running on the 

computer. 
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 (c) Icons represent an application or utility that 

you can start by double clicking that icon. 

 

 

 (d) Operating system software provides the user 

interface. 

 

 (e) Many comm1ands have keyboard shortcuts. 

 

 (f) Paint is one of the application in Accessories. 

  Accessories  

 (g) A word processor is a software package that 

helps to create and edit a document. 

 

 (h) The Internet and the World Wide Web are 

essentially the same thing.  
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 (i) Internet is not a commercial information 

service.  

 (j) The e-mails received are stored in inbox.  

  

11. Explain history of computer in detail. 

 

12. Explain in detail about Notepad. 

 Notepad 

13. What is E-mail? How the send and receive 

messages? 

 

14. Explain the Creating, Edit Formatting and Save 

documents. 

 

15. List out merits and demerits of internet. 
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16. Explain the Installing and Uninstalling new 

Hardware and Software program on your 

computer. 

 

——––––––––– 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

COMPUTER APPLICATIONS 

WINDOWS AND INTERNET 

Time: 3 Hours       Maximusm Marks: 70 

    PART –A      (3 x 3 = 9 Marks) 

Answer any Three questions out of Five questions in 100 words. 

All questions carry equal Marks. 

1. Explain about Memory Unit. 

epidthf myF gw;wp tpsf;Ff. 

2. Explain various applications of Computers. 

fzpdpfs; gy;NtW gad;ghLfis tpsf;fTk;. 

3. What are the advantages of Computer? Explain. 

fzpdpapd; gad; vd;d? tpsf;Ff. 

4. Explain Recycle bin. 

uP-irf;fps; gpd;-I gw;wp tptup. 

5. Explain in detail about WWW 

WWW-it gw;wp tptup. 

PART –B    (3 x 7 = 21 Marks) 

Answer any Three questions out of Five questions in 200 words. 

All questions carry equal Marks. 

6. Explain the different types of Computers. 

gy;NtW tifahd fzpdpfs; tpsf;Ff. 

7. What is Modem? How it is functioning? 

Nkhlk; vd;why; vd;d? vg;gb nray;gLfpwJ? 

8. What is Data and Information? Explain. 

juT kw;Wk; jfty; vd;why; vd;d? tpsf;Ff. 

9. Explain the Basic Computer Operations. 

fzpg;nghwpapd; mbg;gil nray;ghLfs; gw;wp tptup. 

10. Explain the Generation of Computers 

fzpdpapd; jiyKiwfis gw;wp tptup. 
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PART –C     (4 x 10 = 40 Marks) 

Answer any Four questions out of Seven questions in 500 words. 

All questions carry equal Marks. 

11. Explain the various Output devices. 

gy;NtW fzpdp nkhopia tpsf;Ff. 

12. Explain in detail about Edit menu in WORDPAD 

WORDPAD-,y; ,Ue;J nkD gw;wp tpupthf tpsf;fTk;. 

13. Explain history of Computer in detail. 

fzpdpapd; tuyhw;iw tptupf;fTk;. 

14. List out merits and demerits of Internet 

,izaj;jpd; jFjp kw;Wk; FiwghLfis gl;baypLf. 

15. Explain the Installing and Uninstalling new Hardware and Software program on your 

computer. 

cq;fs; fzpdpapy; epWTjy; kw;Wk; Gjpa td;nghUs; kw;Wk; nkd;nghUs; 

epuiy ePf;Fjy; tpsf;fTk;. 

16. What is E-mail? How to send and receive messages? 

kpd;dQ;ry; vd;why; vd;d? jfty;fis vt;thW mDg;GtJ kw;Wk; ngWtJ. 

17. Write short notes on: 

(a) Working with colour 

(b) Working with drawing object. 

rpW Fwpg;G tiuf: 

(m) fyUld; Ntiy nra;tJ 

(M) buhapq; Mg;n[f;l; cld; Ntiy nra;tJ 
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VOCATIONAL DIPLOMA EXAMINATION — 

DECEMBER 2020 

Computer Applications 

MS-WORD AND MS-EXCEL  

Time : 3 hours Maximum marks : 75 

PART A — (5  5 = 25 marks) 

Answer any FIVE questions. 

1. Write notes on Bullets and numbering.  

 

2. What are the features of MS Excel?  

 MS Excel 

3. How we can create charts using MS Excel? 

 MS
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4. Explain the following : 

 (a) SUM  

 (b)  Product. 

  SUM  

  . 

5. How to can insert today’s Date and time in  

MS Excel?  

 MS Excel 

6. Short note on Spell check. 

 

7. What is protection? Write steps for protect your 

document. 

protection 

8. How to modify the table? 
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PART B — (5 × 10 = 50 marks) 

Answer FIVE questions, question 9 and 10 compulsory. 

9. Choose the correct answer :   (10  1 = 10) 

(a) Which one can be used as watermark in a 
word document. 

  (i) Text 

  (ii) Image 

  (iii) Both (i) and (ii) 

  (iv) None 

 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (b) Which item appears dimly behind the main 
body text 

  (i) Water color 

  (ii)  Background 

  (iii)  Watermark 

  (iv) Marker

  (i)  

  (ii)  

  (iii)  

  (iv) 
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 (c) The direction of a rectangular page for 
viewing and printing is called 

  (i) Orientation 

  (ii) Direction 

  (iii) Print Layout  

  (iv) Page setup 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (d) Which item is printed at the bottom of each 
page 

  (i) Header 

  (ii) Foot Note 

  (iii) Footer 

  (iv) none of the above 

  (i)  

  (ii)  

  (iii)  

  (iv) 
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 (e) Color and pattern used to fill a closed shape 
is called 

  (i) Shape 

  (ii) Word Art 

  (iii) Fill Style 

  (iv) Shape fill 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (f) What function displays row data in a column 
a column data in a row?  

  (i) Hyparlink 

  (ii)  Index 

  (iii) Transpose 

  (iv) Hypertext  

  (i)  

  (ii)   

  (iii)  

  (iv)  
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 (g) Except for the ––––––––– function, a formula 
with a logical function shows the word 
‘‘TRUE” or ‘‘FALSE’’ as a result 

  (i)  IF 

  (ii) AND 

  (iii) OR 

  (iv) NOT 

‘‘TRUE”  ‘‘FALSE’’ 

  (i)  IF 

  (ii) AND 

  (iii) OR 

  (iv) NOT 

  (h) Each excel file is called a workbook because. 

  (i) It can contain text and data 

  (ii) It can be modified 

  (iii) It can contain many sheets including 
worksheets and chart sheets 

  (iv) All the above 

  (i)  

  (ii)   

  (iii) 

 

  (iv)  
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 (i) Which types of charts can excel produce? 

  (i) Line graphs and pie charts only 

  (ii) Only line graphs 

  (iii) Bar charts, line graphs and pie charts 

  (iv) All the above 

  (i) 

 

  (ii)    

  (iii) 

 

  (iv)  

 (j) How are data organized in spreadsheet? 

  (i) Linesandspaces 

  (ii) Layers and planes 

  (iii) Rows and columns 

  (iv) None of the above 

  

  (i)  

  (ii)  

  (iii)  

  (iv)  
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10. State whether the following are true or false :  

       (10  1 = 10) 

 (a) In MS Word Formula’ option is in Table 

menu. 

MS Word ‘ ’ 

 (b) In MS Word Merge cells is in Table menu. 

  MS Word 

 (c) In word print preview option is in File menu. 

 (d) Select all the text and graphics in the 

working document or press Ctrl+ A. 

Ctrl+ A.

 (e) Header and Footer option is in view menu. 

 (f) Maximum width of a cell is 12.75. 

12.75.
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 (g) F1 is the shortcut for Help. 

F1

 (h) Sub Total is an example for MS Excel Add —

In. 

MS Add -in 

 (i) In MS Excel Header and Footer are 

displayed in Page Break Preview. 

  MS Excel 

 

 (j) Sort command in Table menu is used to 

arrange the data in table in ascending order. 

11. Explain different paragraph formatting options 

available in MS Word. 

 MS Word 

 

12. Explain Format menu in MS Excel. 

 MS Excel 
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13. Explain briefly find and replace command.  

 

14. What are the uses of MS Excel? 

 MS Excel 

15. Discuss in detail about Tools — Auto correct. 

 

16. Explain Edit menu in MS Word. 

 MS Word 

——––––––––– 



 

 

 

 

VOCATIONAL DIPLOMA EXAMINATION - DECEMBER 2020 

COMPUTER APPLICATIONS 

MS  WORD AND MS EXCEL 

 

Time: 3 Hours       Maximum Marks: 70 

Section A (3 x 3 = 9 Marks) 

Answer any THREE questions out of Five questions in 100 words. 
All questions carry equal marks. 
 
1. Describe about the Editing and Formatting Document. 

vbl;bq; kw;Wk; tbtikg;G Mtzj;ijg; gw;wp tptupf;fTk;. 
 

2. Write short notes on Fonts in MS-Word. 
MS-Word ,y; cs;s vOj;Jf;fspy; FWfpa Fwpg;Gfs; vOjTk;. 
 

3. What is Mail Merge? Explain. 
nkapy; xw;wpizg;G vd;why;  vd;d? 
 

4. How can we create Charts using MS Excel? 
vg;gb MS-vf;nry; gad;gLj;jp tiuglq;fs; cUthf;f KbAk;. 

5. What does indenting the Text mean? 
ciuia cs;js;sy; vd;why; vd;d? 
 

Section B (3 x 7 = 21 Marks) 

Answer any THREE questions out of Five questions in 200 words. 
All questions carry equal marks. 

6. Explain about working with Functions. 
nray;ghLfisr; nray;gLj;JtJ gw;wp tpsf;fTk;. 
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7. Describe the various Text Formats with examples. 
vLj;Jf;fhl;Lld; gy;NtW ciu tbtikg;Gfisg; gw;wp tpsf;Ff. 
 

8. What are the major features of MS Word? 
MS Word ,d; Kf;fpa mk;rq;fs; ahit? 
 

9. Explain some functions in Excel. 
vf;nrypy; rpy nray;ghLfis tpsf;Ff. 
 

10. Explain working with multiple sheets and printing worksheets. 
gy ml;ltizj; jhs;fSld; nray;gly;> ml;ltizfis mr;rply; Mfpad gw;wp 
tpsf;Ff. 
 

Section C (4 x 10 = 40 Marks) 

Answer any FOUR questions out of Seven questions in 500 words. 
All questions carry equal marks. 

11. What are the various Charts in Excel Worksheet? Explain. 
vf;nry; gzpj;jhs; cs;s gy;NtW tiuglq;fs; vd;d? tpsf;Ff. 
 

12. Explain the uses of Conditional Formatting with suitable example. 
epge;jidaw;w tbtikg;Gfisg; gad;gLj;Jtjw;F nghUj;jkhd vLj;Jf;fhl;lhf 
tpsq;FfpwJ. 
 

13. Explain the steps for creating Header and Footer in MS Word. 
MS Word ,y; jiyg;G kw;Wk; mbf;Fwpg;G cUthf;Fk; gbfis tpsf;fTk;. 
 

14. Explain about  the various type of paragraph alignment that can be made?  
vd;dndd;d tifahd gj;jp ,irTfis nra;a KbAk;? 
 

15. Explain the process of changing the margins using Ruler. 
Ruler I gad;gLj;jp Mtzg;gf;fq;fspd; xU msTfis khw;wp mikf;Fk; Kiwia 
tpsf;Ff. 
 

16. Define briefly a Spreadsheet and describe its Basic Structure.  
ml;ltizr; nraypia RUf;fkhf tiuaWj;J mjd; mbg;gil mikg;ig tpsf;Ff. 
 

17. Explain various protection options in Work Sheet. 
nthu;f;rPl;bd; gy;NtW ghJfhg;G topfis gw;wp tptup. 
 

 

 

 



  

 

 

VOCATIONAL DIPLOMA EXAMINATION — 

DECEMBER - 2020 

COMPUTER APPLICATIONS 

MS – POWER POINT AND MS – ACCESS 

Time: 3 Hours Maximum Marks: 75 

SECTION A (5  5 = 25 Marks) 

Answer any FIVE questions. 

1. How will you insert various backgrounds in Power 
Point presentation? 

 

2. How will you run slide show on screen? 

 Slide show Run 

3. Explain the various tools and accessories of  
MS-Access.  

 MS-Access

4. Explain about database creations.  

 Database
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5. What are the features of MS-Access? 

 MS-Access 

6. Explain how to create query in MS-Access. 

 MS-Access Query 

7. What are views? Explain the various views 
available in Power Point.  

 View Power Point

8. How to create reports in MS-Access? 

 MS-Access Report  

SECTION B   (5  10 = 50 Marks) 

Answer any FIVE questions out of Eight questions.  
9 & 10 are compulsory. 

9. Choose the correct answer.   (10  1 = 10) 

 (a) Which of the following is not a database 

object in MS-Access? 

  (i) Tables (ii) Query  

  (iii) Relationship 

  object MS-Access

 

(i)  (ii) 

  (iii)   
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 (b) A part of database that stores only one type 
of data is  

  (i) Report (ii) Field 

  (iii) Query  

Database data

(i)  (ii) 

  (iii)  

 (c) The key uniquely identifies each record in a 
table 

  (i) Primary key (ii) Key 

  (iii) Both 

table

Records

(i)  (ii) 

  (iii)  

 (d) Which of the following command the retrieve 
data from database?  

  (i) Forms (ii) Reports 

  (iii) Queries 

command 

data

(i)  (ii) 

  (iii)  
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 (e) The task of arranging data in order is called. 

  (i) searching  (ii) sorting 

  (iii) ordering  

data

–––––––––

(i)   

   (ii)  

  (iii)  

 (f) Which file format can be added to a Power-

Point? 

  (i) .jpg  (ii) .giv 

  (iii) both 

file format MS-Power Point 

  (i) .jpg  (ii) .giv 

  (iii)  

  (g) To add a header or footer to your handout, 

you can use.  

  (i) The title master  

  (ii) The slide master 

  (iii) The handout master 
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Header Footer 

(i) 

   (ii) 

  (iii)  

 (h) Which command brings you to the first slide 

in your presentation? 

  (i) Page up (ii) Ctrl + Home 

  (iii) Alt + Home 

command slide

(i)  (ii) Ctrl + Home

  (iii) Alt + Home 

 (i) Object on the slide that hold a tent are 

called.  

  (i) Placeholder  (ii) Object holder 

  (iii) Text holder 

Slide object –––––––––

(i) 

   (ii) 

  (iii)  
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 (j) To exit the Power Point 

  (i) Click the application minimize button 

  (ii) Click the document close button  

  (iii) Double click application control menu 

icon.  

  Power-Point  

(i) minimize button

  (ii) close button 

  (iii) 

double click  

10. State True or False :    (10  1 = 10) 

 (a) There is no in-built database in MS-Access. 

   In-Built database 

 (b) A user can create queries using SQL 
commands.  

SQL Command 

Query 

 (c) It is essential to define a primary key in a 
table.  

Table primary key 
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 (d) For creating a query, at a time only one table 

can be used.  

Query Table 

 (e) A table can be displayed in either design 

view or in a datasheet view.  

Table Design view 

Datasheet view  

 (f) Power-Point is a graphical software. 

  Power-Point 

 (g) Sound can be embedded in a Power Point 

presentation.  

Power-Point presenation

 (h) It is not possible to animate different parts of 

a slide.  

slide

animate 

 (i) Char option is not in MS-Power Point.  

  Char option -MS-Power Point

 (j) MS-Power Point is a spread sheet program.  

  MS-Power Point spread sheet 

program. 
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11. Explain the file and edit menu.  

 File Edit 

12. Explain different animation effects.  

 

13. Explain MS-Power Point auto content wizard and 
its basics.  

 Auto Content Wizard 

14. How do you export data in Excel format? 

 MS-Excel format data Export 

 

15. Describe at least two ways of creating a new table.  

 Table 

16. Create a query using query wizard. Write down 
the steps that must be followed to sort the records 
based on a key in descending order.  

 Query Wizard Query 

Record descending 

order

——––––––––– 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

COMPUTER APPLICATIONS 

MS POWERPOINT AND MS ACCESS 

Time: 3 Hours              Maximum Marks: 70 

PART –A     (3 x 3 = 9 Marks) 
Answer any Three questions out of Five questions in 100 words. 
All questions carry equal Marks. 

1. How to access translation options in PowerPoint? 
     PowerPoint-,y; nkhop ngaHg;G tpUg;gq;fis vg;gb mZFtJ?  

2. Explain what you mean by Queries. 
    Queries vd;d vd;W tpsf;Ff.. 

3. Write about the Steps for creating Form Wizard. 
    xU gbt topfhl;b cUthf;Ftjw;fhd topfis vOJ. 

4. How will you run Slide Show on Screen? 
    Slide show  I jpiuapy; vt;thW Run nra;tJ? 

5. What are the features of MS-Access? 

     MS-Access -d; rpwg;Gfs; ahit? 

 
PART –B     (3 x 7 = 21 Marks) 

Answer any Three questions out of Five questions in 200 words. 
All questions carry equal Marks. 
 

    6. Explain how you can create a form in Microsoft Access. 

        Microsoft Access ,y; Form ePq;fs; vt;thW cUthf;fyhk; vd;gij tpsf;Ff.  

   7.  What are Views? Explain the various Views available in PowerPoint. 

      fhl;rpfs; vd;d? gtu;ghz;by; cs;s gy;NtW fUj;Jf;fis tpsf;Ff. 

   8.  Write steps for printing a Query. 

        Query mr;rpLtjw;fhd topfs; vOJq;fs;. 

   9.  Write steps for line spacing in PowerPoint presentation. 

       gtu; ghapz;l; ];Ng]pq; tup ,ilntspf;F topKiwfis vOJq;fs;.  

   10. What are Views? Explain the various views available in Power Point.  
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        View vd;why; vd;d? Power Point&y; cs;s gy;NtW tifahdit gw;wp tptup.  

 

PART –C     (4 x 10 = 40 Marks) 
Answer any Four questions out of Seven questions in 500 words. 
All questions carry equal Marks. 

11. What are the various display options available in the Access options Window? 
mZfy; tpUg;gq;fs; rhsuj;jpy; fpilf;Fk; gy;NtW fhl;rp tpUg;gq;fs; 

vd;d? 

12. What are the ways to create a new form? Explain. 
Gjpa Form cUthf;f topfs; ahit? tpsf;Ff. 

13. Explain creating a table using Design View and Form Wizard View. 
tbtikg;G ghu;it kw;Wk; gbt topfhl;bg; ghu;itiag; gad;gLj;jp xU 

ml;ltizia cUthf;fp tpsf;fTk;. 

14. Explain formatting text in PowerPoint presentation. 
gtu; ghapz;l; tpsf;ff; fhl;rpapy; cs;s tbtikg;G ciu tpsf;fTk;. 

15. Explain entering and editing text in PowerPoint presentation. 
PowerPoint tpsf;ff; fhl;rpapy; cs;spLk; kw;Wk; jpUj;Jk; ciuia tpsf;fTk;. 

16. Explain different Animation Effects.  
gy;NtW mdpNk\d; vngf;l; gw;wp tptup.  

17. Describe at least two ways of creating a new Table.  
Table vt;thW cUthf;FtJ vd;gjid Fiwe;jJ ,uz;L topKiwfSld;   

tpsf;Ff.  

 


